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With the introduction of the Employment Relations Act 2000, which came into force in October 
2000, the need to manage the area of Human Resource has become more important. 

The system has been designed to adapt to your particular organisation s requirements while still 
providing a structured start. 

Employee Information can run fully integrated with MYOB Exo Payroll, or alternatively as a 
standalone product. 

It is important to remember when setting up your Employee Information system that you initially 
concentrate on the areas that are important to your organisation, such as training. By setting up 
one area at time and fine tuning to suit your requirements before going onto the next area you 
will be building a highly effective system. 

Getting Started with MYOB Exo Employee Information 

Before you get underway with setting up MYOB Exo Employee Information we suggest that you 
take the time to familiarise yourself with the general structure and overview of the system. 

We recommend working your way around the Demonstration Company that is installed with the 
package. This will help you learn how to navigate through the various windows and enhance your 
understanding of the information required to set up your company. 

Start the software by double-clicking on the MYOB Exo Employer Services icon on your desktop 
or click the Windows Start button and choose the program from Programs > MYOB Exo Employer 
Services. 

The first thing you will see is the MYOB Login Screen with the Demonstration Company in the list 
of payrolls. Exo Employee Information is a multi-company system (you can have unlimited 
additional companies). Once you add your own company, its name will appear in this list. 

 
The Demonstration Company line will be highlighted. To open a company, either select a 
company and press enter or double-click on it. You must enter the logon details of a user account 
that has been set up in the Exo Employee Information system. 
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After logging in, you are presented with the main window: 

 
The main window includes the following interface features: 

 All functions are available from the main menus (see page 2). 

 Important functions can be accessed by clicking on the icons on the main Toolbar (see 
page 6). Hovering the mouse pointer over these icons (without clicking) will display tool 
tips, which indicate what part of the payroll they access. 

 Keyboard shortcuts are available for common operations. 

Once you are familiar with the interface, you can begin to perform the main functions of the Exo 
Employee Information system: 

 Setting up the details of your company (see page 9) 

 Maintaining employee records 

 Printing reports (see page 97) 
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The Menus 

The menu is the main starting point in Exo Employee Information and allows access to all areas of 
the system. 

File Menu 

Menu Item Description 

New Employee Add a new employee (see page 22) into Exo Employee Information, 
in preparation for logging an Accident and/or Claim against that 
employee. 

Open Employee Access an existing employee (see page 63) to edit contact details, 
risk area, training received and job requirements. 

Terminate/Reinstate Mark ex-employees as no longer being current, i.e. not affecting 
your annual license levels. Reinstate the employee if they return. 

Change Company Exit to the MYOB Login Screen (see page 1) in order to select a 
different company. 

Exit Exit from the program and close down all related files. 

Edit Menu   

Menu Item Description 

Undo Reverse the last keyboard action 

Redo Repeat the last keyboard action 

Cut Move the selected text into the Windows clipboard 

Copy Copy the selected text into the Windows clipboard 

Paste Copy the contents of the Windows clipboard to the current cursor position 

Clear Clear the contents of the currently selected data entry field 

Select All Select the entire data entry field from the current cursor position 
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Maintenance Menu 

Menu Item Description 

Candidates Record contact details for job applicants (see page 65), and attach a CV 
if appropriate. Candidates can be converted to employees at a later 
stage. 

Career Plan Goals List of career ambitions (see page 68) that can be combined in any 
order to form a career plan. 

Employee Groups Set up grouping of employees outside of departments (see page 12). 
This could be grouping of different positions e.g. Managers. Office 
Staff, Account Managers, etc. or areas of employees e.g. 
Administration, Sales etc. 

Exit Interviews This function allows you to set up Exit Interview procedures based on 
Company requirements. Exit interviews are made up of individual 
points (see page 69), which are combined into Exit Interview Plans (see 
page 69). 

Induction This function allows you to set up Induction checklists based on your 
companies specific requirements. Inductions are made up of individual 
bullet points (see page 71), which are combined into Induction Plans 
(see page 72). 

Note Types You are able to set up additional note types (see page 73) and default 
note format. 

Performance 
Review 

This function allows you to set up Performance review formats. 
Performance reviews are made up of individual points (see page 75), 
which are combined into Performance Review Plans (see page 69). 

Position This function allows you to design and maintain the positions (see 
page 14) that employees hold. 

Skills This function allows you to establish and maintain a database of skills 
(see page 78) that can be applied to employees. 

Tasks/Duties This function allows you to establish and maintain a database of tasks 
or duties (see page 80) that can be applied to employees. 

Training This function allows you to create a list of Training Providers (see page 
83) and Training Courses (see page 85), either internal or external. 

Lookup Tables This function allows you to create and maintain the lookup tables (see 
page 89) for Benefit Type, Ethnicity, Place of Birth, Language, Training 
Course Duration, Disciplinary Descriptions, Qualification/Education, and 
Skills. 
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Documents Menu   

Menu Item Description 

Company Documents Attach company documents relating to human resources in 
general. 

Document Templates This allows you to set up document templates (see page 95). 

Visitor Log The OSH department requires that companies keep an up-date 
visitor log (see page 96); this requirement is part of the health and 
safety auditing process. 

Reports Menu   

Menu Item Description 

Print Reports This opens the list of available reports (see page 99). 

Clarity Report Writer This utility enables you to create your own customised reports. 

ReportWriter This is an older utility for customising reports. 

Utilities Menu   

Menu Item Description 

Backup Allows you to backup your data at any time to either floppy disks or 
your hard drive. 

Restore This is used when you need to restore a backup due to hardware 
failure or corruption. 

File Reindex This is a file repair utility. 

Setup Exo Employee 
Information 

Configure the company for use (see page 10). 

User Security This is where you set up the various users who will have access to 
the payroll and allocates what rights they have. MYOB Exo 
Employee Information is a multi-user system. 

Security Groups This allows you to restrict user security access to a subset of your 
employees (see page 107), rather than seeing all employees in the 
system. 

Event Tracking Setting up rules for tracking changes in employee data (see page 
108). 

Event Log A log of changes (see page 107) made within the system for 
auditing purposes. 



Introduction 

6 

Backup Options This allows you to configure settings that affect backups of your 
data. 

Help Menu 

Menu Item Description 

Help Topics Opens the online Help. Help can also be accessed anywhere in 
the program by pressing F1. 

MYOB Education 
Centre 

Opens the MYOB Education Centre website in a web browser. 

What s New in this 
Release 

Opens PDF release notes, detailing new features and resolved 
issues in the current version. 

Online Knowledgebase Opens the MYOB Enterprise Knowledgebase website in a web 
browser. 

Show Reminders Displays all employee notes with Reminder dates up to today s 
date that have not yet been marked as completed. 

Setup Cycle This is used to access the Setup Cycle (see page 9) when initially 
setting up a company. 

Upgrade Software This is a tool with which you can upgrade your current version of 
software (see page 109), providing you have the most recently 
available CD. 

Upgrade Software 
Online 

This function accesses the Internet to upgrade your current 
version of MYOB software online (see page 111). 

About Shows the current version number and MYOB contact details. 
Press F11 at any time to view the About window independently of 
the menu. 

 

  

http://help.myob.com.au/exo/index_esnz.htm
http://myobexo.custhelp.com/
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The Toolbar 

The following icons are available in the toolbar of the main Exo Employee Information interface: 

Icon Function Description 

 

New 
Employee 

Add an employee to Exo Employee Information (see page 22). If 
you have an integrated system (Exo Payroll and Exo Employee 
Information) all new employees must be added through Exo 
Payroll. 

 

Edit Employee Access existing Exo Employee Information employees (see page 
22) and related items for the purpose of editing/reviewing. 

 

Employee 
Notes 

Opens the selected employee s personnel notes. This window 
can also be accessed via the F12 key. 

 

Training Access to centralised database of employees training records 

 

Performance 
Review 

Access to centralised database of employees Performance 
Review records 

 

Disciplinary 
Action 

Access to centralised database of employees Disciplinary Action 

 

Skills Access to centralised database of employees Skills 

 

Tasks & Duties Access to centralised database of employees Tasks and Duties 

 

Print Reports Opens the list of available reports. 

 

Help 
  

This provides you with extensive Help relating to the setting up 
and the running of your Health and Safety. Help can also be 
accessed anywhere in the program by pressing F1. 

 

Backup This is a facility to archive a copy of your data files, in the case of 
needing to Restore/Rollback to them at some point. 

 

Maintenance Provides quick access to the Maintenance Form  a central 
access point for your Exo Employee Information-related 
masterfiles. 

 

Diary Opens the Diary, which is a form of a daily planner, giving you a 
place to enter comments on any given day, for Payroll company-
related tasks, appointments and reminders. 

 

Show Items Opens a window showing all available toolbar icons, where you 
can choose which icons to display and which to hide. 

 

Exit Closes the application and returns to Windows. 

 



8 

 

Adding a Company 

MYOB Exo Employee Information can have unlimited live  companies in the same program, in 
addition to the Demonstration Company. 

After opening Exo Employee Information, the first screen that appears is the MYOB Login Screen. 

 
This screen allows you to add a new company, as a separate entity from the Demonstration 
Company. Click Add or press F4 to add a Company. The following screen appears: 
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Company Name  Enter the name for the new company. This is the name that will appear in the list 
of companies. 

Directory  The directory name will be automatically generated for you, based on the first few 
characters of your company name. 

Copy information from an existing company  This option allows you to copy the basic set up data 
from another company if one exists. 

Tick the Copy Information From box, and select the closest matching company from the list. If in 
doubt, choose the Demonstration Company. You will then be able to specify which areas of the 
other company you wish to copy by ticking the appropriate boxes. 

Once the procedure is complete click Save or press F10 and you will be taken to your new 
company. 

Once in the new company you will be presented with the Setup Cycle screen (see page 9). This 
screen will step you through the process of configuring the various essential settings. 

Deleting Companies 

If you wish to delete a company for any reason, select the company on the Login Screen and click 
Delete or press F6. You are then prompted for the name of the company to delete. Select by 
clicking on the company of your choice. You are then asked to confirm that you want to delete 
this company. Click No to cancel, or click Yes to proceed. Before you delete any companies 
forever, it is recommended that you make a backup first. 
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The Employee Information Setup Cycle 

Before you can enter any employee information and commence the preparation of your database 
it is necessary to set up the system to handle your company s unique requirements. 

Although some of this preparation may be handled by MYOB in the course of their installation and 
training, it is necessary to have an overview so that you may be better equipped to successfully 
understand your system. 

These procedures will be discussed in the order that they are usually performed. 

 
Click on each of the steps in turn to perform all of the necessary operations for setting up your 
company. 

 Company Setup (see page 10) 

 Add Employee Groups (see page 12) 

 Add Positions (see page 14) 

 Add Employees (see page 22) 

 Add Employee Information Details (see page 60) 

 Edit Employees (see page 63) 
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Step One - Company Setup 

 
Select Step One from the Setup Cycle. The Company setup section identifies the company and its 
employee group structure. 

 
Employer Details  Enter the details of the company name, address, suburb, city, and the 
company s IRD Number. 

Default employee order  When scrolling through your employee masterfile or pay screens you can 
either scroll through in alphabetical or numeric staff code order. Click on the order you wish to use 
as your default. 

User-Defined  Click these buttons to set the name and caption of the two User Defined buttons 
that appear on the Other tab (see page 30) of the Employee Maintenance window. User-Defined 
information is free-form - it can be any type of information that you may want to keep. 
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Employee Group Structure 

This determines the overall breakdown of Employee Group Codes (see page 12), their field sizes 
and number of sub-groups, which will be available when adding your employee groups 
masterfile. The employee groups structure is based on a number which can be made up of a 
maximum of 12 digits broken down into up to four separate levels. 

The structure that you put in place here determines how the employee groups are set up. 
Operators that are familiar with the Cost Centre structure in MYOB Exo Payroll will see the 
similarities in this area. 

In the screenshot above, the structure that is being used is as follows: 

Area - 1 digit 

Location - 1 digit 

This means that Employee Group Codes will consist of two digits: the first indicates the group s 
area (e.g. 1 = Auckland, 2 = Wellington, 3 = Christchurch), and the second indicates its location (e.g. 
1 = Admin, 2 = Sales, 3 = Warehouse). This would mean that a code of 12 would indicate the 
Auckland Sales group and the code for the Christchurch Administration group would be 31. 

In most cases the employee group structure may reflect the department set up in the payroll. 

The purpose of the employee group structure is to group employees together, so that when 
assigning training, skills, jobs and tasks you are able to assign these using your employee groups. 
The ideal is that the employees are grouped to reflect similar requirements e.g. a lot of the training 
requirements for the Administration department would be similar in skill and knowledge 
requirements etc. So it would make sense to group your administration team together. 

Before setting up your employee groups have a look through the system to see where the 
employee groups are used i.e. the allocating of training etc to get an idea of how to set your 
structure up based on your requirements. 
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Step Two - Add Employee Groups 

 
The structure for your employee groups is set up in Step One. In Step Two you set up employee 
group codes and descriptive names. If you have a relatively straightforward employee group 
requirement your structure would look similar to the screen shown below: 

Select Step Two from the Employee Information Setup Cycle. A list of Employee Groups appears. 
Click Add to create a new group, or highlight an existing group and click Select to edit it. 

 
Code  Enter the identification code for the group. This code must match the Employee Group 
Structure set up on the Company Setup screen (see page 10). 

Name  Enter a name for the group. 

Manager Name  Enter the name of the manager in charge of the group 

Email  Enter the manager s email address. 

Phone  Enter the manager s contact phone number. 

Employee Group Analysis 

This area displays the breakdown of the Code, according to the Employee Group Structure set up 
on the Company Setup screen (see page 10). 
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Step Three - Add Positions 

 
Select Step Three from the Setup Cycle to set up the positions that will be assigned to employees. 

 
The setup process has two stages: 

 Job Descriptions (see page 14) 
 Positions (see page 15) 

Once you have made additions and alterations to each window as necessary, click Exit or press 
ESC to return to the Setup Cycle. 
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Adding Job Descriptions 

 
The Job Descriptions section of the Position Setup window (see page 14) lets you describe the 
main types of activities carried out by employees. 

The simplest scenario is where an employee might have one position and one job description; 
however, many employers seek people who are multi-talented and capable of taking on hybrid 
roles. Multiple job descriptions may combine together to form one position. 

Creating Job Descriptions 

Clicking the Job Descriptions button opens a list of all job descriptions. Click Add to create a new 
description, or highlight an existing description and click Select to edit it. Descriptions are added 
and edited on the Job Description Point Maintenance window: 

 
Name  Enter a name for the description. 

Description  Enter a description of what the job description entails. This can be as long or as short 
as necessary. 

Once you have created your job Description Points you are then able to create your Positions (see 
page 15). 
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Adding Positions 

 
Although it is important that all employees are assigned a position to make the system effective, 
the degree to which this area is used is completely dependent on your organisation s 
requirements. For example, some organisations may wish to use this area to a very low level, they 
may enter quite global options for positions such as Office Worker which would incorporate, 
receptionists, office Junior, Secretary etc. Other organizations will have more complex 
requirements for positions where they will use this area to enter more detailed Position Analysis. 

The Positions section of the Position Setup window (see page 14) lets you set up and define the 
positions that employees will be assigned. Clicking the Positions button displays list of all positions. 
Click Add to create a new position, or highlight an existing position and click Select to edit it. 

TIP: The Maintenance menu, which provides access to Position maintenance, can also be 
accessed at any time by pressing F2. 

This window contains six tabs: 

 Details (see page 16) 
 Skill/Trainings (see page 17) 
 Tasks/Duties (see page 17) 
 Job Description (see page 18) 
 Incumbents (see page 19) 
 User Defined (see page 20) 

Details 

This tab contains basic details about the position. 
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Position  Enter a name for the position 

Position Description  Enter in the position description details. The information that is entered will 
be displayed in the job description. Ensure that the Job Description that you are preparing is as 
clear and effective as possible. 

Position Requirements  This is not a required field, but may be used to enter additional 
information such as personality traits needed for the position, e.g. organised , past industry 
experience, etc. 

Skills/Training 

This tab is where you are able to assign skills (see page 78) and training (see page 85) to a 
particular position. 

 
To assign skills and/or training, click on the Select button in the appropriate area, which displays 
the skills and/or training that you have created. These areas are not compulsory but are 
recommended to ensure that your system is effective. 
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Tasks/Duties 

This tab is similar to the Skills and Training tab, and is used to assign Tasks or Duties (see page 80) 
to the individual positions. 

 
Click the Select button to display the list of tasks and duties you have created and assign them to 
the position. 
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Job Description 

Position 

This tab lets you set up and print a Job Description for the position. You can preview and print the 

job description at any time by clicking the  button. 

 
Header  The information entered here will appear at the top of the Job Description you are 
creating. 

Points  This area lists the Job Description points (see page 14) assigned to this Job Description. 
Click the Add button to display a list of available Job Description points to assign. 

Footer  The information entered in this field will be shown at the foot of the Job Description 
document for this position. 
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Incumbents 

This tab lists all employees who have currently hold this position. 

 
Employees with this position  A list of the incumbents is displayed once the position has been 
assigned to one or more employees. 

  



MYOB EXO Employee Information 

21 

User Defined 

This tab contains extra generic fields that may be used to customise your data. You can rename 
some of the User Defined  fields, and use them to track information which may not have been 
included in the set screens provided with the system. 

 
With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field. 
 Date - Enter a date in the format dd/mm/yyyy. 
 Text - Enter a short comment here. 
 Memo - Enter a long comment or description here. It can run over several lines. 

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

NOTE: The names you enter for the User Defined fields apply to all positions, but the 
information you enter for the fields  values is specific to the plan you are currently editing. 
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Step Four - Add Employees 

 
You may add employees at any time. You can add all of your employees into the system at this 
point, or you may choose to only add employee when they have had accidents. How employees 
are added depends on whether or not MYOB Exo Employee Information is installed standalone or 
integrated with MYOB Exo Payroll. 

Standalone System (Exo Employee Information only) 

Employees are added from the Setup Cycle. You will need contact phone numbers and addresses, 
emergency contact details, and IRD numbers. 

Select Step Four of the Setup Cycle. The following window appears: 

 

 To add a new employee, enter the Employee Code number and click Add. 

 To convert an existing candidate to an employee, click the Candidate button. A picklist of 
candidates appears; double-click on the candiate that you want to convert to an employee. 

In either case, the Employee Maintenance window (see page 22) opens, where you can enter 
details for the new employee. When adding a new employee, only the Employee Details tab (see 
page 22) is available to begin with. Once all required information is entered on this tab, the other 
tabs become available. 

NOTE: When converting a candidate to an employee, a new employee record is created, 
but the original candidate record is not deleted. It can be deleted manually, or you can keep 
it as a historical record. 

Integrated System (Exo Payroll & Exo Employee Information) 

Employees are not added in MYOB Exo Employee Information. When you add your employee 
into MYOB Exo Payroll, the employee is automatically brought across with the same employee 
code into Exo Employee Information. See the Exo Payroll documentation for information on how 
to add employees. 

NOTE: In an integrated system, candidates are converted to employees in Exo Payroll - if 
any candidates have been added, a Candidates button is available on the Add Employee 
window in Exo Payroll. 
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Employee Details 

When adding a new employee, only the Employee Details tab that is available initially. This is 
deliberate, as there are compulsory details required on this tab before you can continue. If you are 
opening/editing an existing employee, all tabs are immediately available. 

 
The Employee Details tab contains the following details: 

Required Information 

The details in this section must be completed before the other tabs on the Employee Maintenance 
window become available. 

Code  The unique numerical code that identifies the employee. 

Title  Select employee s title from drop down selection box. 

Surname  Enter employee s surname. 

First Name  Enter employee s first name(s). 

Alpha Code  For sorting and listing employees the system uses the first eight letters of the 
employee s surname as a sort code. This is shown here automatically. This alpha code must be 
unique. This alpha code must be unique. If a message appears that says Alpha Code cannot be 
empty and must be unique  or invalid input , it means that this Alpha Code is already in use, 
probably for an employee with the same surname. To correct this, change the Alpha Code to 
something else, e.g. by making the last character of the Alpha Code the employee s first initial. 

Start Date  Enter the employee s start date. The employee s years of service are displayed next to 
the start date. This value is calculated as the system date minus the Start Date. 

Employee Group  Specify the Employee Group (see page 12) that this employee belongs to. 

Position  Specify the Position (see page 15) that this employee holds. 
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Personal Details 

These are all self-explanatory. If the Birth date is entered in MYOB Exo Payroll, it will be displayed 
in this field. The Gender will also come through from the Exo Payroll. 

Next to some fields you will see a   button; this indicates that you have the ability to add pre-set 
selections, depending on your organization s specific requirements. 

If the system is integrated with the Health and Safety module, the following information is 
automatically inserted: 

 Country of Birth 
 Ethnicity 
 Home Language 

Employment Information 

Occupation  The employee s occupation, as taken from MYOB Exo Payroll. This is not necessarily 
the same as the employee s Position. If the system is operated as a standalone system, there is no 
need to enter the Occupation. 

Pay Frequency  Select the pay frequency this employee belongs to 

IRD Number  Enter the employee s IRD number. The system will validate the number entered as 
being a valid IRD number. 

Tax Code  Enter the employee s tax code. Note that some tax codes are not accessible unless a 
valid IRD number has been entered. 

SLCIR / SLBOR  If the employee has a Student Loan tax code (i.e. one that ends in SL ), these 
fields becomes available. They specify any additional Student Loan repayments that may have 
been set up for the employee. 

Full / Part Time  Select an appropriate employment status from the following list: Full-Time, Part-
Time. 

Salary / Wage  Select an appropriate form of remuneration from the following list: Salary, Wage. 

Permanent / Casual  Select an appropriate employment status from the following list: Permanent, 
Casual. 

Photo 

You can insert an employee s photo if your organisation requires this. Click the Insert Photo button 
and select the image file. Only bitmap (.BMP) files are supported. 

To remove the employee s photo, click Clear. 
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Contact Details 

The Contact Details tab of the Employee Maintenance window holds contact details for the 
employee. The employee s contact details are added from MYOB Exo Payroll if the system is 
being operated as an integrated system. However you will need to enter the additional 
information such as the employees cell phone and email address if applicable. 

 
Enter the following details into the relevant fields: 

Employee Contact Details 

Enter the following address details for the employee: 

 Postal Address 
 Postal Suburb 
 Postal City 
 Phone number 
 Mobile phone number 
 Internal telephone extension 
 Email address 
 Home Address 
 Home Suburb 
 Home City 
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Emergency Contact 

Enter the following details for the employee s emergency contact person: 

 Name 
 Address 
 Suburb 
 City 
 Phone number 

Supervisor Details 

Enter the following details for the employee s supervisor: 

 Name 
 Email address 
 Phone number 

User Defined 

The User Defined tab of the Employee Maintenance window contains extra generic fields that 
may be used to customise your data. You can rename some of the User Defined  fields, and use 
them to track information that may not have been included in the set screens provided with the 
system. 

 
With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 
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The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field. 
 Date - Enter a date in the format dd/mm/yyyy. 
 Text - Enter a short comment here. 
 Memo - Enter a long comment or description here. It can run over several lines. 

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

NOTE: The names you enter for the User Defined fields apply to all employees, but the 
information you enter for the fields  values is specific to the employee you are currently 
editing. For example, if you change one of the text fields to Middle Name , then this field 
will be called Middle Name  for all employees; however, the actual contents of the field are 
entered separately for each employee. 

Documents 

The Documents tab of the Employee Maintenance window lets you keep a copy of all records 
relating to the employee. 

 
Click one of the options in the Add dropdown button to add a new document for the employee. 
You can: 

 Attach an existing document file (see page 91). 

 Create a new document (see page 91) using the built-in word processing interface. You can 
create a new blank document, or create a document that is based on a Document 
Template (see page 95). 
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Double-click on an existing document to open it. If the document is an attached file, it will open in 
the default editor for the type of file; if it is a document created in Exo Employee Information, it will 
open in the built-in word processing interface, where it can be edited. 

Right-click on a document and select Edit document properties to edit the document s Name, 
Category and/or Description. 

To remove a document from the employee s file, select it and click the Delete button. 

Notes 

The Notes tab of the Employee Maintenance window enables you to make or edit personnel 
notes on any employee. 

 
You can enter general Notes at any time. These notes can also be printed out in the Employees 
Note report at any time. 

Notes can be entered or edited from the Notes tab of the Employee masterfile screen, by selecting 
Employee Notes from the File menu or by pressing F12 anywhere in the program. 
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Adding a Note 

From the Notes Tab, click Add or press F4 to add a Note. The following screen appears. 

 
Date  This defaults to the current date. This would normally be left unchanged. 

Entered By  This field displays the User who entered the note originally. 

Note Type  Select one of the note types set up on the Note Types window (see page 73). In some 
cases a Default note will be automatically entered by the system, such as when an employee takes 
Sick Leave. These default notes can still be edited at a later stage. 

Reminder Date  Here you can enter a date to turn this note into a Reminder note. Reminder Notes 
pop up on the Show Reminders screen when you log in to Exo Employee Information. When the 
date is removed, the note will no longer appear as a reminder. 

Recipients  If this note is to be a Reminder Note, you should select one or more recipients of the 

note. Click the  button for a selection. 

All users are listed on the left; all recipients of the reminder are listed on the right. You can click on 
users and drag them from one list to the other. 

>  Moves the selected user to the list of recipients. 

>>  Moves all users to the list of recipients. 

<  Moves the selected user from the list of recipients back to the main list. 

<<  Moves all users from the list of recipients back to the main list. 

To edit an existing note, select the note and double-click it, or click Edit. This opens the same 
screen used to add notes, allowing you to edit the note s details. 

Click Save or press F10 to save when you are finished editing. 
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Other 

The Other tab of the Employee Maintenance window lets you edit the HR information for a 
specific employee. 

 
Click on a button to edit the relevant information. Buttons for the following areas are available: 

 Candidates (see page 31) 
 Induction (see page 31) 
 Qualification & Education (see page 33) 
 Skills (see page 35) 
 Employee Tasks (see page 37) 
 Training (see page 39) 
 Performance Review (see page 41) 
 Career Planning (see page 45) 
 Remuneration History (see page 47) 
 Work History (see page 49) 
 Leave History (see page 51) 
 Discipline History (see page 52) 
 Benefits History (see page 54) 
 Exit Interview (see page 56) 

The two User Defined options are customised on the Company Setup window (see page 10). 

NOTE: Leave History and Remuneration History will come through from the payroll for those 
organizations operating the system integrated with MYOB Exo Payroll. For organizations 
operating the system standalone, information can be inserted directly into these screens. 
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Candidate 

If the employee was formerly a candidate, you can view the information logged against that 
person when they were a candidate by clicking the Candidate button on the Other tab of the 
Employee Maintenance window (see page 30). 

Candidates are created on the Candidate Maintenance (see page 65) window. 

Candidates are converted to employees as part of the Add Employees (see page 22) function. 

Induction 

Induction Plans (see page 72) are assigned to an employee by clicking the Induction button on the 
Other tab of the Employee Maintenance window (see page 30). 

Clicking this button displays a list of the plans already assigned to the employee; initially this list will 
be empty. 
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Click the Add button to display a list of all available Induction Plans. Highlight a plan that is suited 
to the employee s requirement and click Select. This will take you to the following window: 

 
In this window you will see the points (steps) displayed. Tick the box in the Done column once 
each step is completed. This will automatically insert the date that the job was ticked as being 
completed. If you require the date to be changed you can override it. 

To enter details for a point, double-click on it and you will be taken to a window that contains a 
text box for entering additional information. You also have the ability to enter in a reminder date 
relating to this, which would result in a reminder being displayed on entry into the system and 
thereafter until the step was signed off as being completed. 

Click the  button to preview and print out a copy of the Induction Plan. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 
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Notes 

This tab stores notes and reminders for actions relating to the induction plan. 

Qualification & Education 

The recording of employee s qualifications can prove to be valuable when working with 
employees in developing their roles. For those companies that have a succession planning 
requirement, will also find this area extremely helpful. 

By creating a database of qualification options and then assigning these at the employee level this 
can become an easily managed area providing valuable information to assist in your organisation s 
human resource planning. 

Access the record of an employee s qualifications by clicking the Qualification & Education button 
on the Other tab of the Employee Maintenance window (see page 30). 

Clicking this button displays a list of the qualifications already recorded for the employee; initially 
this list will be empty. 
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Click Add to create a new qualification, or select an existing qualification and click Edit to change 
its details. Qualifications are added and edited on the following window: 

 
Qualification Name  Enter in the name of the Qualification. 

Type  Select the type of qualification. Click the  button to open a window listing all types, where 
new types can be added. You are also able to edit or delete any of the existing qualification types. 

Date Attained  Enter the date attained if applicable; if the qualification has not been attained at the 
time of entering the information leave the field empty. 

Institution  Enter the name of the institution that the employee attended or is attending. 

Course Details  Enter the details of the course. 

Course/Paper  Enter the course or paper that this relates to, if applicable. 

Comments  Enter any additional information that may be applicable. 

Reminder  You are able to enter in a date that you wish to receive a reminder relating to this 
qualification. It may be an agreed date that you will get back to the employee to see how things 
are progressing. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 
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The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the qualification. 

Skills 

Although you can assign Skills (see page 78) to an Employee Group (see page 12) or Position (see 
page 15), there may be occasions where you are required to assign a skill to an individual 
employee, e.g. if an employee has an existing skill that is not necessarily a requirement for their 
current position, and this should be kept in mind for future positions that become available 
requiring that skill. 

Access the record of an employee s skills by clicking the Skills button on the Other tab of the 
Employee Maintenance window (see page 30). 
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To add skills, click the Add button to display a list of all available skills: 

 
Tick the boxes for all skills you want to add and click Save. The skills are added to the list on the 
Employee Skills window. 

To edit an existing skill, select the skill on the Employee Skills window and click the Edit button. 
This opens the following window: 

 
To view information on the skill itself, click View Skill Details. This displays the Skill Maintenance 
window (see page 78), with all properties read-only. 
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Completed  Enter the date when this employee attained the skill. 

Rating  Some skills may be developed over time, and rated according to a grading system of some 
sort. You can alter an employee s grade here as they develop their skills. 

Comments  Enter any comments regarding the employee s attainment of, or proficiency in, this 
skill. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the skill. 

Employee Tasks 

Although you can assign Tasks or Duties (see page 80) to an Employee Group (see page 12) or 
Position (see page 15), there may be occasions where you are required to assign a task/duty to an 
individual employee. 

Access the record of an employee s tasks/duties by clicking the Employee Tasks button on the 
Other tab of the Employee Maintenance window (see page 30). 
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To add tasks/duties, click the Add button to display a list of all available tasks/duties: 

 
Highlight a task/duty and click Select to add it to the Employee Tasks/Duties window. 

To edit an existing task/duty, select the task/duty on the Employee Tasks/Duties window and click 
the Edit button. This opens the following window: 

 
To view information on the task/duty itself, click View Task/Duty. This displays the Task Duty 
Maintenance window (see page 80), with all properties read-only. 
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Key Performance Indicators  Describe any Key Performance Indicators (KPIs) that relate to the 
task/duty. 

Comments  Enter any comments relating to the task/duty as it applies to the employee. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the task. 

Training 

Although you can assign Training Courses (see page 85) to an Employee Group (see page 12) or 
Position (see page 15), there may be occasions where you are required to assign a course to an 
individual employee. 

Access the record of an employee s training courses by clicking the Training button on the Other 
tab of the Employee Maintenance window (see page 30). 
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To add training, click the Add button to display a list of all available training courses: 

 
Highlight a training course and click Select to add it to the Employee Training window. 

To edit an existing course, select the course on the Employee Training window and click the Edit 
button. This opens the following window: 

 
To view information on the training course itself, click View Training Course. This displays the 
Training Courses Maintenance window (see page 85), with all properties read-only. 
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Booked  Enter the date that the course is/was booked for. 

Reminder Date  To set up a reminder for when the training course is due to take place, enter a 
reminder date and specify recipients. 

Completed  Enter that date that the course was completed on. 

Result  Enter the result of the training course, e.g. complete . 

Actual Course Cost  Enter the actual cost of the course, as opposed to the course value entered at 
on the Training Courses Maintenance window (see page 85). This can cover circumstances where 
you get a group discount or if you need to account for accommodation or travel costs. 

Comments  Enter any comments relating to the training course as it applies to the employee. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the training course. 
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Performance Review 

Performance Review Plans (see page 75) are assigned to an employee by clicking the 
Performance Review button on the Other tab of the Employee Maintenance window (see page 
30). 

 
Click the Add button to display a list of all available Performance Review Plans. Highlight a plan 
that is suited to the employee s requirement and click Select to add it to the Performance Review 
window. 
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To edit an existing plan, select the plan on the Performance Review window and click the Edit 
button. This opens the following window: 

 
In this window you will see the points (steps) displayed. Tick the box in the Done column once 
each step is completed. This will automatically insert the date that the job was ticked as being 
completed. If you require the date to be changed you can override it. 

To enter details for a point, double-click on it and you will be taken to a window that contains a 
text box for entering additional information. You also have the ability to enter in a reminder date 
relating to this, which would result in a reminder being displayed on entry into the system and 
thereafter until the step was signed off as being completed. 

Click the  button to preview and print out a copy of the Performance Review Plan. 



Setting up EXO Employee Information 

44 

Reviewer Details 

 
Enter the details of the person who will be conducting the performance review on this tab. 

History 

 
You can use this tab to enter a historical record of any comments that apply from one review to 
the next. 
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User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the performance review plan. 

Career Planning 

Access an employee s plan for career advancement by clicking the Career Planning button on the 
Other tab of the Employee Maintenance window (see page 30). 
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To add a career plan, click the Add button. To edit an existing plan, select the plan and click Edit. 
Plans are added and edited on the following window: 

 
Position  In the position box the current position the employee holds will be displayed. You are 
then able to select a future position the employee has expressed an interest in. 

Remind Me  You are able to enter in a date you wish to receive a reminder relating to this career 
plan. It may be an agreed date that you will get back to the employee to see how things are 
progressing. 

Comment  Enter any additional information if applicable. 

Goals  Add Career Plan Goals (see page 68) and enter any additional information. To add a new 
goal, click the Add button or press F4 to display a list of Career Plan Goals to select from. 

Reminder  You have the ability to enter a reminder date for each goal entered. This is particularly 
important if the Career plan is made up of several goals which may require individual monitoring 
during the duration of the Plan. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 
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Remuneration History 

MYOB Exo Employee Information keeps a log of changes to employees  salary or wages. Where it 
is integrated with MYOB Exo Payroll, the payroll automatically generates a note every time there is 
a change to an employee s salary or hourly rate. These notes are displayed in Employee 
Information, where new notes can be added. 

Access an employee s remuneration history by clicking the Remuneration History button on the 
Other tab of the Employee Maintenance window (see page 30). 
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To add a remuneration note, click the Add button. To edit an existing note, select the plan and 
click Edit. Notes are added and edited on the following window: 

 
Date  Today s date is automatically entered. 

Note Type  Enter a Note Type (see page 73) for the note. If you do not know the code you require, 
press ENTER in this field to select a Note Type from a list. 

Authorised By  Enter the name of the person that authorised the change in remuneration. 

Date From / To  Enter the date(s) that the current wages/salary apply from/to. 

Comments  Enter any additional comments relating to the change in remuneration. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 
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Work History 

MYOB Exo Employee Information keeps track of any previous positions held by employees since 
being with the company. This is useful for obtaining a quick overview of the employee s 
progression. Any changes to the Position of an employee will automatically generate a note on 
this window, and new notes can be added. 

Note: It is important to remember that the Occupation displayed on the Employee Details 
tab (see page 22) of the Employee Maintenance window is not the same as the Position 
assigned in Employee Information. 

Access an employee s work history by clicking the Work History button on the Other tab of the 
Employee Maintenance window (see page 30). 
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To add a work history note, click the Add button. To edit an existing note, select the plan and click 
Edit. Notes are added and edited on the following window: 

 
Date  Today s date is automatically entered. 

Note Type  Defaults to Work History . 

Authorised By  Enter the name of the person that authorised the change in position. 

Position  Enter the new position. 

Date From / To  Enter the date(s) that the current position applies from/to. 

Comments  Enter any additional comments relating to the change in position. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 
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Leave History 

MYOB Exo Employee Information keeps a log of any leave taken by the employee. Where is 
integrated with MYOB Exo Payroll, the payroll automatically generates a note every time Holiday 
Pay, Sick Leave, etc. is paid out to the employee. These notes are displayed in Employee 
Information, where new notes can be added. 

Access an employee s leave history by clicking the Leave History button on the Other tab of the 
Employee Maintenance window (see page 30). 

 
To add a leave history note, click the Add button. To edit an existing note, select the plan and click 
Edit. Notes are added and edited on the following window: 
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Date  Today s date is automatically entered. 

Note Type  Enter a Note Type (see page 73) for the note. If you do not know the code you require, 
press ENTER in this field to select a Note Type from a list. 

Authorised By  Enter the name of the person that authorised the leave. 

Date From / To  Enter the date(s) that the leave applies from/to. 

Comments  Enter any additional comments relating to the leave. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Discipline History 

Although it is the hope of all organizations that the need to discipline staff is rare if at all, it is 
important that if the occasion arises that the organisation records the information correctly. 

Access an employee s discipline history by clicking the Discipline History button on the Other tab 
of the Employee Maintenance window (see page 30). 
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To add a discipline record, click the Add button. To edit an existing record, select the record and 
click Edit. Records are added and edited on the following window: 

 

Discipline Description  Select the type of disciplinary action taken. Click the   button to open a 
window listing all types, where new types can be added. You are also able to edit or delete any of 
the existing discipline types. 

Date of Discipline  Enter the date disciplinary action was taken. 

Time  Enter the time of the discipline meeting. 

Incident Witness  Enter the name of the witness to the incident that resulted in the disciplinary 
action. 

Incident Details  Enter the details of the incident that resulted in the disciplinary action. 

Meeting Witness  Enter the name of the witness at the meeting. 

Meeting Details  Enter details of the meeting including the employee s views on the incident. 

Proposed Action  Enter details of the proposed action to be taken. 

Click the  button to preview and print out a copy of the Disciplinary Action report. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 
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The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the discipline. 

Benefits History 

MYOB Exo Employee Information keeps a log of any employee  benefits outside of their 
remuneration history, e.g. company cars, superannuation, medical insurance etc. 

Access an employee s benefits by clicking the Benefits History button on the Other tab of the 
Employee Maintenance window (see page 30). 
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To add a benefit, click the Add button. To edit an existing benefit, select it and click Edit. Benefits 
are added and edited on the following window: 

 

Benefit  Select the type of benefit. Click the  button to open a window listing all types, where 
new types can be added. You are also able to edit or delete any of the existing benefit types. 

Reference  Enter a reference if applicable, e.g. medical insurance number if the company is 
providing the employee with medical insurance cover. 

Date From / To  Enter the date(s) that the benefit applies from/to. 

Reminder  To set up a reminder for when the training course is due to take place, enter a reminder 
date and specify recipients. 

Details  Enter any other additional information pertaining to the benefit. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 
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Exit Interview 

Exit Interview Plans (see page 69) are assigned to an employee by clicking the Exit Interview 
button on the Other tab of the Employee Maintenance window (see page 30). 

If no plan has been assigned to the employee yet, you are asked to choose a plant: 

 
Once a plan has been selected, the following window appears: 
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In this window you will see the points (steps) displayed. Tick the box in the Done column once 
each step is completed. This will automatically insert the date that the job was ticked as being 
completed. If you require the date to be changed you can override it. 

To enter details for a point, double-click on it and you will be taken to a window that contains a 
text box for entering additional information. You also have the ability to enter in a reminder date 
relating to this, which would result in a reminder being displayed on entry into the system and 
thereafter until the step was signed off as being completed. 

Click the  button to preview and print out a copy of the Exit Interview Plan. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the exit interview plan. 
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Security 

The Security tab of the Employee Maintenance window establishes who is able to look at the 
selected employee s data. This enables security to be self-contained to one or many sets of 
employees per user. 

 
The tab lists all User Security Groups (see page 107) that the employee belongs to. Click the 
Security Groups button to change the Security Groups assigned to the employee. 
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All unassigned Security Groups are listed on the left; all Security Groups assigned to the employee 
are listed on the right. You can click on groups and drag them from one list to the other. 

>  Moves the selected group to the list of assigned groups. 

>>  Moves all groups to the list of assigned groups. 

<  Moves the selected group from the list of assigned groups back to the main list. 

<<  Moves all groups from the list of assigned groups back to the main list. 

Terminate/Reinstate 

How employees are terminated and reinstated depends on whether or not MYOB Exo Employee 
Information is installed standalone or integrated with MYOB Exo Payroll. 

Integrated System (Exo Payroll & Exo Employee Information) 

Employees are not terminated or reinstated in MYOB Exo Employee Information; these operations 
are performed in Exo Payroll. See the Exo Payroll documentation for information on how to add 
employees. 

Standalone System (Exo Employee Information only) 

Employees can be terminated or reinstated at any time. To terminate an employee or reinstate a 
previously terminated employee, select Terminate/Reinstate from the File Menu. You will be 
asked to select an employee. Enter the code for the employee you want to terminate/reinstate 
and the following window appears: 

 
Employee  Displays the code and full name of the selected employee. 

Employee is currently  Displays the employee s current status. This will be one of: 

 ACTIVE, followed by the employee s start date 
 TERMINATED, followed by the employee s termination date 

If the employee is currently active, a Terminate Date field and Terminate button appears below. If 
the employee is currently terminated, a Reinstate Date field and Reinstate button appear. 

Enter the date of the employee s termination or reinstatement then click Terminate/Reinstate to 
terminate/reinstate the employee. 

You will be asked to confirm that you want to proceed. Click Yes to continue. 

NOTE: Terminated employees will still appear in any report that covers a period in which 
they attended work. 
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Step Five - Add Employee Information Details 

 

 
This step lets you set up different areas that can then be associated with employees. The following 
areas can be set up: 

 Induction 
 Training 
 Skills 
 Tasks and Duties 
 Performance Reviews 
 Exit Interviews 

It is recommended that you concentrate on one area at a time, based on your priority. 

Induction 

All organizations handle the Induction Process differently and in a lot of cases, depending on the 
different areas within their particular organisation, the Induction Process can differ from 
department to department. 

MYOB Exo Employee Information gives you the ability to design your own induction processes; it 
is possible to have any number of Induction Plans (see page 72) prepared on your system, which 
can then be assigned to employees when they start with your organisation. 

The Exo Employee Information system works by creating a database of Induction Points (see page 
71), containing procedures that can be assigned to one or more Induction Plans. 

Induction plans are then assigned to new employees (see page 31) on an individual basis 

Click the  button set up induction plans for new employees. 

 
The setup process has two stages: 

 Induction Points (see page 71) 
 Induction Plans (see page 72) 
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Training 

MYOB Exo Employee Information lets you record details of the providers of training courses that 
your organisation uses, and the training courses that your employees attend. 

Training courses are allocated to Positions and/or Employee Groups, and can also be assigned to 
employees (see page 39) on an individual basis. 

Click the  button to set up employee training. 

 
This is the area where you set up the Training information. 

The setup process has two stages: 

 Training Providers (see page 83) 
 Training Courses (see page 85) 

Skills 

MYOB Exo Employee Information lets you keep a database of skills that can be assigned to 
employees. This is an optional part of the system. 

Click the  button to set up a database of skills (see page 78), which can then be assigned to 
the employees. 

Skills are allocated to Positions and/or Employee Groups, and can also be assigned to employees 
(see page 35) on an individual basis. 

Tasks/Duties 

MYOB Exo Employee Information lets you keep a database of tasks and duties that can be 
assigned to employees. This is an optional part of the system. 

Click the  button to set up a database of tasks and duties (see page 80), including knowledge 
and responsibilities. Once the task or duty has been created it can then be assigned to positions, 
employee groups or a combination of both. 
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Tasks and duties are allocated to Positions and/or Employee Groups, and can also be assigned to 
employees (see page 37) on an individual basis. 

Performance Review 

All organizations handle the Induction Process differently and in a lot of cases, depending on the 
different areas within their particular organisation, the Induction Process can differ from 
department to department. 

MYOB Exo Employee Information gives you the ability to design your own induction processes; it 
is possible to have any number of Performance Review Plans (see page 75) prepared on your 
system, which can then be assigned to employees when they start with your organisation. You 
are able to set up any number of Plans depending on your requirements but there will be certain 
points that will be shared between the plans i.e. Team work, Communication etc. 

The Exo Employee Information system works by creating a database of Performance Review 
Points (see page 75), containing procedures that can be assigned to one or more Induction Plans. 

Induction plans are then assigned to new employees (see page 41) on an individual basis. 

Click the  button to set up performance review plans that can be assigned to employees on 
a regular basis. 

 
The setup process has two stages: 

 Review Points (see page 75) 
 Review Plans (see page 75) 
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Exit Interview 

Each company handles the departure of an employee differently, but more and more 
organisations are realising that when a good employee leaves, information offered by them in a 
well-managed exit interview can be valuable. 

MYOB Exo Employee Information gives you the ability to design your own exit interviews; it is 
possible to have any number of Exit Interview Plans (see page 69) prepared on your system, 
which can then be assigned to an employee at the time of their leaving. 

The Exo Employee Information system works by creating a database of Exit Interview Points (see 
page 69), containing procedures or questions that can be assigned to one or more Exit Interview 
Plans. 

When an employee leaves, an exit interview plan can be assigned (see page 56) to them on an 
individual basis. 

Click the  button to set up exit interview plans that can be assigned to employees who are 
leaving the organisation. 

 
The setup process has two stages: 

 Exit Interview Points (see page 69) 
 Exit Interview Plan (see page 69) 
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Step Six - Edit Employees 

 
The actions of adding an employee and opening/editing an employee are essentially the same 
thing; the functionality and screen layout are the same. The only difference is that when adding an 
employee, you will get a new employee code and blank screen to begin with. When editing, you 
will begin with a screen filled with the details you have entered in previous data entry sessions, 
ready to be modified. 

Having Edit Employees as a separate final step in the Setup Cycle allows you to make changes to 
employees such as assigning plans and training, which may have been added after employees 
were first added. Also, in the case where Exo Employee Information is integrated with MYOB Exo 
Payroll, the Add Employee option is not available, as employees are added in Exo Payroll - in this 
case, the Edit Employees step is the only way to alter employee details. 

Select Step Six from the Setup Cycle and the following screen appears: 

 
Enter the Employee Code for the employee you want to edit and press ENTER, or click Find to 
select the employee from a list. The Employee Maintenance screen for the selected employee 
appears, starting on the Employee Details tab (see page 22). 
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Candidates 

MYOB Exo Employee Information gives you the ability to store information on candidates for 
positions you are offering. You can store information on applicants and their suitability for 
particular positions. You are also able to store their interview information, resume/CV etc. 
Candidates who are accepted for a position can be converted to full employees (see page 22). 

To access candidate records, select Candidates from the Maintenance menu. A list of candidates 
appears. Click Add to create a new candidate or select an existing candidate and click Select to 
edit them. Candidate records are added and edited on the Candidate Maintenance window. 

Candidate Details 

 
Enter the candidate s personal details and contact information. 

You can add a photograph of the candidate by clicking the Insert File button. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 
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The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Documents 

This tab lets you keep a copy all records relating to the candidate. This may include a letter of 
offer, interview transcript, CV etc. Any documents entered in here will be transferred across if the 
candidate becomes an employee. 

 
Click one of the options in the Add dropdown button to add a new document for the candidate. 
You can: 

 Attach an existing document file (see page 91). 

 Create a new document (see page 91) using the built-in word processing interface. You can 
create a new blank document, or create a document that is based on a Document 
Template (see page 95). 

Double-click on an existing document to open it. If the document is an attached file, it will open in 
the default editor for the type of file; if it is a document created in Exo Employee Information, it will 
open in the built-in word processing interface, where it can be edited. 

Right-click on a document and select Edit document properties to edit the document s Name, 
Category and/or Description. 

To remove a document from the candidate s file, select it and click the Delete button. 
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Notes 

This tab stores notes and reminders for actions relating to the candidate. 

Security 

This tab establishes who is able to look at the selected candidate s data. This enables security to be 
self-contained to one or many sets of candidates per user. 

 
The tab lists all User Security Groups (see page 107) that the employee belongs to. Click the Edit 
button to change the Security Groups assigned to the candidate. 
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All unassigned Security Groups are listed on the left; all Security Groups assigned to the employee 
are listed on the right. You can click on groups and drag them from one list to the other. 

>  Moves the selected group to the list of assigned groups. 

>>  Moves all groups to the list of assigned groups. 

<  Moves the selected group from the list of assigned groups back to the main list. 

<<  Moves all groups from the list of assigned groups back to the main list. 

Career Plan Goals 

Career Plans (see page 45) can be assigned to all employees. The ability to manage employees  
career planning is a valuable asset in any organisation. Although the career planning feature is not 
a compulsory one, it is nonetheless important. Career plans are made up of individual career 
planning options or goals, which can be re-used in multiple plans. 

TIP: This area can also be used for Succession Planning if that is a requirement in your 
organisation. 

To set up Career Plan Goals, select Career Plan Goals from the Maintenance menu. A list of goals 
appears. Click Add to create a new goal, or highlight an existing goal and click Select to edit it. 
Career Plan Goals are added and edited on the following window: 

 
Name  Enter a short name for the goal. 

Description  Describe the goal in full. 
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Exit Interviews 

Exit Interview Points 

MYOB Exo Employee Information gives you the ability to design your own exit interviews; it is 
possible to have any number of Exit Interview Plans (see page 69) prepared on your system, 
which can then be assigned to an employee at the time of their leaving. Exit Interview Plans 
involve a selection of Exit Interview Points, which define the individual steps or questions involved 
in the interview. 

To set up Exit Interview Points, select Exit Interviews > Exit Interview Points from the Maintenance 
menu. A list of points appears. Click Add to create a new point, or highlight an existing point and 
click Select to edit it. Exit Interview Points are added and edited on the following window: 

 
Name  Enter the name of the point. 

Description  Enter a full description of the procedure or question that this point involves, so the 
person interviewing the departing employee has a guideline for the information required. 
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Exit Interview Plans 

MYOB Exo Employee Information gives you the ability to design your own exit interviews; it is 
possible to have any number of Exit Interview Plans prepared on your system, which can then be 
assigned to an employee at the time of their leaving. Exit Interview Plans involve a selection of Exit 
Interview Points (see page 69), which define the individual steps or questions involved in the 
interview. 

To set up Exit Interview Plans, select Exit Interviews > Exit Interview Plans from the Maintenance 
menu. A list of plans appears. Click Add to create a new plan, or highlight an existing plan and click 
Select to edit it. Exit Interview Plans are added and edited on the following window: 

 

Click the  button to preview and print out a copy of the Exit Interview Plan. 

Exit Interview  Enter a name for the plan. 

Header  Enter information that will be displayed at the top of the Exit Interview Plan when it is 
printed out. This can include instructions on conducting the interview. 

Points  Assign Exit Interview Points (see page 69) to the plan. The following operations are 
available: 

 Click the Add button to add a new point to the plan. 
 Select a point and click Edit to open the Interview Points Maintenance window (see page 

69) to edit the text of the point. 
 Select a point and click Delete to remove it from the plan. 
 Once added, points can be dragged up and down to reorder them. 



MYOB EXO Employee Information 

71 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the exit interview plan. 

Induction 

Induction Bullet Points 

MYOB Exo Employee Information gives you the ability to design your own induction processes; it 
is possible to have any number of Induction Plans (see page 72) prepared on your system, which 
can then be assigned to employees when they start with your organisation. Induction Plans 
involve a selection of Induction Points, which define the individual steps or questions involved in 
the process. 

To set up Induction Points, select Induction > Induction Bullet Points from the Maintenance menu. 
A list of points appears. Click Add to create a new point, or highlight an existing point and click 
Select to edit it. Induction Bullet Points are added and edited on the following window: 
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Name  Enter the name of the Induction Point. 

Description  Enter details of the point, so that the person handling the induction has a guideline 
for the information to be covered. 

Induction Plans 

MYOB Exo Employee Information gives you the ability to design your own induction processes; it 
is possible to have any number of Induction Plans prepared on your system, which can then be 
assigned to employees when they start with your organisation. Induction Plans involve a selection 
of Induction Points (see page 71), which define the individual steps or questions involved in the 
process. 

To set up Induction Plans, select Induction > Induction Plans from the Maintenance menu. A list of 
plans appears. Click Add to create a new plan, or highlight an existing plan and click Select to edit 
it. Induction Plans are added and edited on the following window: 

 

Click the  button to preview and print out a copy of the Exit Interview Plan. 

Induction Plan  Enter a name for the Induction Plan. 

Induction Belongs To  If you have also purchased the MYOB Health and Safety module, you can 
classify the Induction as being a function of either Health and Safety or Exo Employee Information. 
For example, a Safety Induction Plan could be sourced from Health and Safety, but a 
Management Induction Plan could be sourced from Employee Information. 

A key objective of the Induction process is to provide a set of instructions that adequately 
safeguard the physical health and well-being of new employees and/or contractors that are 
coming into the workplace. OSH guidelines should be followed, when creating an Induction Plan 

 refer to http://www.osh.dol.govt.nz for more details. 

http://www.osh.dol.govt.nz/
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Header  Enter information which will be displayed at the top of the Induction Plan when it is 
printed out. This may include instructions on conducting the Induction process. 

Points  Assign Induction Bullet Points (see page 71) to the plan. The following operations are 
available: 

 Click the Add button to add a new point to the plan. 
 Select a point and click Edit to open the Induction Point Maintenance window (see page 71) 

to edit the text of the point. 
 Select a point and click Delete to remove it from the plan. 
 Once added, points can be dragged up and down to reorder them. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the induction plan. 
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Note Types 

Exo Employee Information automatically inserts notes into an employee s Notes file when certain 
conditions occur. Notes of various types can be created. 

These notes build up in the employee s Notes file creating a pay activity history that can be 
reported on at any time via the Notes report. You can create your own Note Types and add them 
to the automatically created notes. 

Select Note Types from the Maintenance menu to open the Note Types Maintenance window. 
Press F9 or click Find for a list of all Note Types. Press F4 or click Add to add a new Note Type: 

 
Note Type  Enter the Note Type code that you wish to use. It can be letters, numbers, or a 
combination of the two. Note Types are also case sensitive so you may choose between upper 
and lower case letters. 

Description  Enter a name to describe the Note Type. 

Default Note  Enter a default note or template to be added whenever a note of this type is 
created. Using a default note saves typing in the same information repeatedly and ensures 
conformity in notes added by users. The default note can be edited or added to if necessary. 
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Performance Review 

Performance Review Points 

MYOB Exo Employee Information gives you the ability to design your own performance review 
processes; it is possible to have any number of Performance Review Plans (see page 75) prepared 
on your system, which can then be assigned to employees when they start with your organisation. 
Performance Review Plans involve a selection of Performance Review Points, which define the 
individual steps or questions involved in the review. 

To set up Performance Review Points, select Performance Review > Performance Review Points 
from the Maintenance menu. A list of points appears. Click Add to create a new point, or highlight 
an existing point and click Select to edit it. Performance Review Points are added and edited on 
the following window: 

 
Name  Enter the name of the Performance Review Point. 

Description  Enter details of the point, so that the person handling the induction has a guideline 
for the information to be covered. 
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Performance Review Plans 

MYOB Exo Employee Information gives you the ability to design your own performance review 
processes; it is possible to have any number of Performance Review Plans prepared on your 
system, which can then be assigned to employees when they start with your organisation. 
Performance Review Plans involve a selection of Performance Review Points (see page 75), which 
define the individual steps or questions involved in the review. 

To set up Performance Review Plans, select Performance Review > Performance Review Plans 
from the Maintenance menu. A list of plans appears. Click Add to create a new plan, or highlight 
an existing plan and click Select to edit it. Performance Review Plans are added and edited on the 
following window: 

 

Click the  button to preview and print out a copy of the Exit Interview Plan. 

Name  Enter a name for the Performance Review Plan. 

Header  Enter information that will be displayed at the top of the Performance Review Plan when 
it is printed out. This may include instructions on conducting the performance review. 

Points  Assign Performance Review Points (see page 75) to the plan. The following operations are 
available: 

 Click the Add button to add a new point to the plan. 
 Select a point and click Edit to open the Performance Review Point Maintenance window 

(see page 75) to edit the text of the point. 
 Select a point and click Delete to remove it from the plan. 
 Once added, points can be dragged up and down to reorder them. 
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Reviewer 

Enter the contact details of the person whose responsibility it is to carry out the Performance 
Review. 

 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Notes 

This tab stores notes and reminders for actions relating to the performance review plan. 



Employee Maintenance 

78 

Skills 

MYOB Exo Employee Information lets you keep a database of skills that can be assigned to 
employees. This is an optional part of the system. The importance of monitoring skills is based 
entirely on each companies particular requirements; however, if it is important to be able to 
manage skill levels, keeping track of employee skills can prove to be a valuable tool in managing 
your organisation s Human Resource requirements. 

To set up skills, select Skills from the Maintenance menu. A list of skills appears. Click Add to create 
a new skill, or select an existing skill and click Select to edit it. Skills are added and edited using the 
following window: 

 

Click the  button to preview and print out a document that details the skill. 

Details 

Alpha Code  Enter a short code for the skill. This can be either alphabetical, numerical or a 
combination of both and up to 10 characters. 

Name  Enter the name of the skill. 

Skill Type  Select the type of skill. Click the  button to open a window listing all types, where 
new types can be added. You are also able to edit or delete any of the existing skill types.   

Skill Details  Enter the details (or description) of the skill. 

Key Performance Indicators  Enter any Key Performance Indicators that apply. 
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User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Allocate 

Skills can be assigned to Positions (see page 15) and/or Employee Groups (see page 12), meaning 
that they will be assigned to any employees that hold one of those positions or belong to one of 
those groups. 

NOTE: Skills can also be assigned to employees (see page 35) on an individual basis. 
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To assign the skill to positions and/or Employee Groups, click the Select button in the appropriate 
area, which displays the available positions/groups: 

 
All unassigned positions/groups are listed on the left; all positions/groups that the skill is assigned 
to are listed on the right. You can click on items and drag them from one list to the other. 

>  Moves the selected item to the list on the right. 

>>  Moves all items to the list on the right. 

<  Moves the selected item from the list on the right back to the main list. 

<<  Moves all items from the list on the right back to the main list. 

Notes 

This tab stores notes and reminders for actions relating to the skill. 

Tasks/Duties 

MYOB Exo Employee Information lets you keep a database of tasks and duties that can be 
assigned to employees. This is an optional part of the system. The importance of tasks and duties 
is based entirely on each company s particular requirements; however, if it is important to be able 
to manage the responsibilities and knowledge levels outside of standard skills and qualifications, it 
can prove to be a valuable tool in managing your organisation s Human Resource requirements. 
This area can be used to create a database of knowledge e.g. knowledge of current market trends, 
or responsibilities e.g. reporting requirements, budgets, targets etc. 
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To set up tasks and duties, select Tasks/Duties from the Maintenance menu. A list of tasks/duties 
appears. Click Add to create a new task/duty, or select an existing task/duty and click Select to edit 
it. Tasks/duties are added and edited using the following window: 

 

Click the  button to preview and print out a document that details the task/duty. 

Details 

Alpha Code  Enter a short code for the task or duty. This can be alphabetical, numerical or a 
combination of both and up to 10 Characters. 

Name  Enter the name of the task or duty. 

Details  Enter the details (or description) of the task or duty 

Key Performance Indicators  Enter any Key Performance Indicators that apply. 

User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 
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Allocate 

Tasks and duties can be assigned to Positions (see page 15) and/or Employee Groups (see page 
12), meaning that they will be assigned to any employees that hold one of those positions or 
belong to one of those groups. 

NOTE: Tasks/duties can also be assigned to employees (see page 37) on an individual basis. 

 
To assign the task or duty to positions and/or Employee Groups, click the Select button in the 
appropriate area, which displays the available positions/groups: 

 



MYOB EXO Employee Information 

83 

All unassigned positions/groups are listed on the left; all positions/groups that the task or duty is 
assigned to are listed on the right. You can click on items and drag them from one list to the other. 

>  Moves the selected item to the list on the right. 

>>  Moves all items to the list on the right. 

<  Moves the selected item from the list on the right back to the main list. 

<<  Moves all items from the list on the right back to the main list. 

Notes 

This tab stores notes and reminders for actions relating to the task/duty. 

Training 

Training Providers 

MYOB Exo Employee Information lets you record details of the providers of training courses that 
your organisation uses, and the Training Courses (see page 85) that your employees attend. 

To set up Training Providers, select Training > Training Providers from the Maintenance menu. A 
list of providers appears. Click Add to create a new provider, or select an existing provider and click 
Select to edit it. Training Providers are added and edited using the following window: 
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Details 

Training Provider  Enter a code for your Training Provider. The code can be alphabetical, 
numerical or a combination of both with up to 12 characters. Enter the name of the Training 
Provider in the next field. 

Contact Details  Enter the following contact information in the relevant fields: 

 Contact Name 
 Phone number 
 Fax number 
 Email address 
 Website 
 Physical (Street) Address 
 Postal Address 

Instructor/Company Profiles 

 
Instructor s Profile  Enter information relating to the individual instructor that may be relevant in 
selecting training courses. 

Location  Enter any extra details of the location of the trainings/seminars, especially if training 
courses are available at locations different from the addresses specified on the Details tab. 

Company Profile  Enter details of the company s profile that may be relevant in selecting training 
courses. 

Notes 

This tab stores notes and reminders for actions relating to the training provider. 



MYOB EXO Employee Information 

85 

Training Courses 

MYOB Exo Employee Information lets you record details of the providers of training courses (see 
page 83) that your organisation uses, and the Training Courses that your employees attend. 

To set up Training Courses, select Training > Training Courses from the Maintenance menu. A list 
of courses appears. Click Add to create a new course, or select an existing course and click Select 
to edit it. Training Courses are added and edited using the following window: 

 

Course Details 

Alpha Code  Enter in a short code for the course. The code can be alphabetical or numerical, or a 
combination of both with up to 10 characters. 

Name  Enter the full name of the course. 

Provider  Select the Training Provider (see page 83) that offers this course. 

Training Type  Select the type of training. Click the   button to open a window listing all types, 
where new types can be added. You are also able to edit or delete any of the existing types.   

Course Description  Enter descriptive information about the course. 

Course Objective  Describe the objectives of the course. 

Prerequisites  Enter any prerequisites for the course, e.g. attendees may be required to have 
completed the beginners and intermediate course prior to the commencement of an advanced 
course. 

Required Material  Enter details of any material that is required for these courses. 
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Other Details 

 

Automatically Reassign Training 

If the course is one that should be undertaken on a regular basis, then you can set the course to 
be automatically reassigned at the required intervals.   

To use this option, tick the Automatically Reassign training option, then specify how regularly you 
need to assign the course. You will also need to select what the anniversary is based on e.g. 
specific date, employee start date etc. 

To be automatically reminded that the course will be due again, tick the Reminder due option and 
specify when you want to be reminded. 

Training Review Details  Enter the training review details, e.g. are you required to get updated 
information for the course. 

Course Schedule  Enter the course schedule if applicable. 

Key Points  Enter any key points. 

Duration  Select the duration of the course. Click the  button to open a window listing all 
possible durations, where new durations can be added. You are also able to edit or delete any of 
the existing durations. 

Course Value  Enter the course value in dollars and cents. Remember to be consistent when 
adding information relating to the course value; make a decision on whether course values 
entered will be inclusive or exclusive of GST. 
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User Defined  

The User Defined tab contains extra generic fields that may be used to customise your data. You 
can rename some of the User Defined  fields, and use them to track information that may not 
have been included in the set screens provided with the system. 

With User Defined Fields you can extend the power of the Exo Employee Information system to 
record items of interest that are not otherwise covered elsewhere. 

The following types of User Defined Field are available: 

 Logical - Place a tick in the box to turn on a logical field.  
 Date - Enter a date in the format dd/mm/yyyy.  
 Text - Enter a short comment here.  
 Memo - Enter a long comment or description here. It can run over several lines.  

To give a meaningful name to a field, double-click on the User Defined  name; this will make the 
caption editable. 

Provider Details 

These details are filled in automatically, based on the Training Provider selected on the Course 
Details tab. They can be altered manually if necessary. 
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Allocate 

Training Courses can be assigned to Positions (see page 15) and/or Employee Groups (see page 
12), meaning that they will be assigned to any employees that hold one of those positions or 
belong to one of those groups. 

NOTE: Training Courses can also be assigned to employees (see page 39) on an individual 
basis. 

 
To assign the training course to positions and/or Employee Groups, click the Select button in the 
appropriate area, which displays the available positions/groups: 
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All unassigned positions/groups are listed on the left; all positions/groups that the training course 
is assigned to are listed on the right. You can click on items and drag them from one list to the 
other. 

>  Moves the selected item to the list on the right. 

>>  Moves all items to the list on the right. 

<  Moves the selected item from the list on the right back to the main list. 

<<  Moves all items from the list on the right back to the main list. 

Notes 

This tab stores notes and reminders for actions relating to the training course.   

Lookup Tables 

Several windows in the Exo Employee Information system allow you to select properties from a 
lookup table or list , which can be edited and added to suit the needs of your organisation. These 
lists can be edited from the window that they relate to, but they can also be edited directly from 
the Maintenance menu. 

Select one of the following lookup table from the Lookup Tables sub-menu under the 
Maintenance menu: 

 Benefit Types - used on the Benefits History (see page 54) window. 

 Disciplinary Descriptions - used on the Discipline History (see page 52) window. 

 Ethnicity - used on the Employee Details (see page 22) tab of the Employee Maintenance 
window. 

 Language - used on the Employee Details (see page 22) tab of the Employee Maintenance 
window. 

 Place of Birth - used on the Employee Details (see page 22) tab of the Employee 
Maintenance window. 

 Qualification/Education - used on the Qualification & Education (see page 33) window. 

 Skills - used on the Skills Maintenance (see page 78) window. 

 Training Course Duration - used on the Training Courses Maintenance (see page 85) 
window. 
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To add an item to a lookup table, click the Add button. Enter the new item into the text field at the 
bottom of the window and click Save. 

To edit an item on a lookup table, double-click on it or highlight it and click the Select button. The 
text of the item appears in the text field at the bottom of the window. Make any changes and click 
Save. 
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Adding Documents 

All documents relating to an employee are displayed on the Documents tab of the Employee 
Maintenance window (see page 27). All documents relating to a candidate are displayed on the 
Documents tab of the Candidate Maintenance window (see page 66). 

To add a new document to an employee or candidate s file, select an option from the Add 
dropdown button on this tab. The drop down has three options: 

 Click Attach File to create a new blank document using Exo Employee Information s built-in 
word processing interface. 

 Click Create Document to attach an existing document. 

 Click Create from Template to create a new document based on an existing document 
templates (see page 95). 

To add general documentation that is not specific to an individual record, use the Company 
Documents option on the Documents menu (see page 94). 

Attaching a File 

You can attach any existing file to an employee record. 

To attach an existing document to an employee record, select Attach File from the Add dropdown 
button. A standard Open window appears - browse to find the document, then click OK. You will 
then be prompted to enter details for the document: 

 
Enter the name and a description for the document (for later reference), and select a Category 
(you can enter a new category, or select an existing one from the dropdown). Click the Save 
button and the new document now appears on the Documents tab of the Employee Maintenance 
window. Double-clicking on an attached document opens it in the default editor for the 
document s type, e.g. a Word document will open in Microsoft Word. Right-clicking on a 
document and selecting Edit document properties lets you edit the document s Name, Category 
and/or Description. 
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Attached files are copied to the Database\employeefiles or Database\candidatefiles folder under 
the default Employer Services folder (usually Payrollv). A separate sub-folder exists for each 
employee/candidate; sub-folders are named after the employee or candidate s ID number. 

NOTE: If an employee or candidate record is deleted, that record s folder and all of the 
associated documents are also deleted. 

NOTE: Files attached to employees and candidates are included in company backups if the 
Include Employee Document option is ticked on the Backup Options window. 

Creating a New Document 

To create a new document, select Create Document from the Add dropdown button. A window 
opens where you can enter details for the new document: 

 
Enter the name and a description for the document (for later reference), and select a Category 
(you can enter a new category, or select an existing one from the dropdown). Click the Continue 
button and the word processing interface appears showing a blank document: 
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The word-processing interface in Exo Employee Information uses the RTF (Rich Text Format) 
standard. This means that plain text can be bolded, italicized, underlined and coloured, and text 
can be centred or right-aligned. The formatting functions are controlled by the toolbar buttons 
and the options in Format menu. 

Once you have entered your document text, click the Save button. 

Creating a Document from a Template 

To create a new document, select Create from Template from the Add dropdown button. A 
window opens where you can select the template to use: 

 
All available Document Templates are listed here. Select the template to base the document on 
and click Select. A window opens where you can enter details for the new document: 
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Enter the name and a description for the document (for later reference), and select a Category 
(you can enter a new category, or select an existing one from the dropdown). Click the Continue 
button and the word processing interface appears showing the default template text. Edit the 
document as normal and click the Save button once all edits have been made. 

Company Documents 

Selecting Company Documents from the Documents menu opens the Company Documents 
window, where you can attach document files related to human resources in general. 

 
Click the Add button to attach a new company document. A standard Open window appears - 
browse to find the document, then click OK. You will then be prompted to enter details for the 
document: 
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Enter the Name and a Description for the document (for later reference), and select a Category 
(you can enter a new category, or select an existing one from the dropdown). Click the Save 
button and the new document now appears on the Company Documents window. 

Attached files are copied to the Database\companyfiles folder under the default Employer 
Services folder (usually Payrollv). 

NOTE: Files in the companyfiles folder are included in company backups if the Include 
Company Documents? option is ticked on the Backup Options window. 

Double-click on an existing document, or select the document and click Open Document, to open 
it in the default editor for the type of file. 

Select a document and click Edit to edit the document s Name, Category and/or Description. 

To remove a document from the employee s file, select it and click the Delete button. 

Document Templates 

MYOB Exo Employee Information includes a word processing function that can be used to create 
documents to attach to Employees (see page 27) or Candidates (see page 65). You can set up 
document templates to use as a basis for common types of documents. 

Select Document Templates from the Documents menu. A list of templates is displayed. Click Add 
to create a new template, or select an existing template and click Edit to edit it. 

Document templates, like documents, are edited using the built-in word processing interface. 

 
The word-processing interface in Exo Employee Information uses the RTF (Rich Text Format) 
standard. This means that plain text can be bolded, italicized, underlined and coloured, and text 
can be centred or right-aligned. The formatting functions are controlled by the toolbar buttons 
and the options in Format menu. 
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Once you have entered your document text, click the Save button then the Exit button. You will 
then be prompted to enter a name and description for the template: 

 
Enter the name and a description for the document (for later reference), then click the Save 
button. Your template now appears in the Templates window.   

Visitor Log 

OSH Requires companies to keep an up-date visitor log, as this is part of the auditing procedure. 
You can set up multiple visitor logs to be printed out and filled in by visitors. 

Select Visitor Log from the Documents menu. The Visitor Log window appears: 

 
The Visitor Log has a pre-defined format, but you can customise the header note that appears at 
the top of the log. Edit the Header Note field if necessary, then click Preview to display a preview 
of the visitor log. From the preview screen, you can print out copies of the log for use. 

If you require multiple visitor logs for different areas, click the Add button to create more logs, 
each with a different header note. 
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Printing Reports 

 
Selecting Print Reports from the Reports menu or clicking the Print Reports button on the toolbar 
opens the Select Report window. 

 
This screen shows the list of reports (see page 99) you can print information from, arranged into 
tabs. This also shows you what each report is used for. 
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Double-click on the report that you want to print or highlight it and click Select. This opens the 
Print Report options screen: 

 
Reports can be printed in a variety of ways, depending on the options selected here. 

Sort Orders 

Sort Order 1  If a choice of primary sort order is available for a particular report, the first choice will 
be highlighted. The options in the list could include: 

 Employee Code 
 Employee Alpha 
 Employee Group 

Sort Order 2  If a secondary sort order is available, the first choice will be highlighted. This means 
that the Sort Order 2 option will only be available if you have something other than Employee 
Code or Alpha highlighted in Sort Order 1, e.g. Induction Plan. The options in the list could include: 

 Employee Code 
 Employee Alpha 

Selection Ranges 

Employee Code/Employee Alpha/Employee Group Code  Enter values here if you want a report 
for a particular employee or range of employees. These fields validate that you have entered a 
correct code. To look up a list of employee codes, enter zero here. 

Other reports have selection ranges specific to the information being reported on, e.g. Induction 
Plan, Note Type, Skill or Position. Enter values to restrict the report to a subset of these items. 

Options 

If the report has other options specific to that report (see page 101), these can be accessed by 
clicking the Report Options button. 
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Output Options 

Destination  Select where the report should be directed to. Choose from: 

 Printer 
 Screen 
 File (PDF) 
 CSV Output 
 Excel Output (XLSX) 

Printer  This displays the name of the printer that you are printing to. Select the Setup Print option 
to display printing options before the report is printed; otherwise the report will be sent directly to 
the printer using the default options. 

File Name  This displays the name of the file that will be created when File  or CSV Output  are 
selected. 

Number of copies  The default number of copies is 1. Enter the number of copies you require. 

Available Reports 

MYOB Exo Employee Information s reports concern insurance providers requirements, OSH 
requirements, reminders and masterfile listings. 

Employee Reports 

Report Content 

Candidate Details Lists all Candidates in the system, with key details. 

Disciplinary Action Lists all Disciplinary incidents by employee, with key 
details. 

Employee Benefits Lists all Benefits by employee, with key details. 

Employee Career Planning Lists all employees that have been assigned a Career 
Plan, including details of the Career Plans and Career 
Plan Goals in each plan. 

Employee Details Displays personal, contact and supervisor details for all 
selected employees. 

Employee Details Summary Displays summarised key details of all selected 
employees. 

Employee Exit Interviews Lists all employees that have been assigned an Exit 
Interview Plan, including details of the Exit Interview 
Plans and Exit Interview Points in each plan. 

Employee Induction Lists all employees that have been assigned an 
Induction Plan, including details of the Induction Plans 
and Induction Bullet Points in each plan. 
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Employee Leave History Lists all Leave (Holiday Pay, Sick Pay, etc.) recorded for 
employees. 

Employee Notes Lists all Employee Notes recorded for employees. 

Employee Performance Reviews Lists all employees that have been assigned a 
Performance Review Plan, including details of the 
Performance Review Plans and Performance Review 
Points in each plan. 

Employee Quals. & Education Lists all Qualifications and Education by employee, with 
key details. 

Employee Renum. & Benefits Lists all remuneration changes and Benefits recorded for 
all employees, with key details. 

Employee Remuneration Lists all remuneration changes by employee, with key 
details. 

Employee Skills Lists the skills assigned to all selected employees. 

Employee Tasks/Duties Lists the tasks and duties assigned to all selected 
employees. 

Employee Training Lists the Training Courses assigned to all selected 
employees, with key details. 

Employee Work History Displays the Work History of all selected employees, 
showing any changes in Position. 

User Defined1 Produces a report based on the user-defined fields set 
up for the User Defined1 button on the Other tab of the 
Employee Maintenance window. 

User Defined2 Produces a report based on the user-defined fields set 
up for the User Defined2 button on the Other tab of the 
Employee Maintenance window. 

Maintenance Reports 

Report Content 

Employee Groups Lists all Employee Groups, displaying a breakdown of their 
Codes. 

Exit Interview Procedures Lists all Exit Interview Points in the system. 

Induction Plan Prints out a copy of the selected Induction Plans. 

Performance Reviews Prints out a copy of the selected Performance Review Plans. 

Positions Lists all Positions in the system, with key details. 
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Skills by Employee Group Lists all skills, sorted by the Employee Groups that they are 
allocated to. 

Skills by Position Lists all skills, sorted by the Positions that they are allocated to. 

Skills by Skill Lists all skills in alphabetical order. 

Tasks/Duties by 
Employee Group 

Lists all tasks/duties, sorted by the Employee Groups that they 
are allocated to. 

Tasks/Duties by Position Lists all tasks/duties, sorted by the Positions that they are 
allocated to. 

Tasks/Duties by 
Tasks/Duties 

Lists all tasks/duties in alphabetical order. 

User Security Lists all the users that have access to the system and the areas 
they can access. 

Training Reports 

Report Content 

Training Courses Lists all Training Courses in the system, with key details. 

Training Providers Lists all Training Providers in the system, with key details. 

Report Options 

Many options are common throughout all of the reports. For example, Detailed Report means a 
line for each record that meets your criteria will be displayed. Options specific to individual reports 
are detailed below. 

Employee Reports 

Candidate Details 

 Show employed candidates - select this option to include candidates who have since been 
employed by the organisation. 

Disciplinary Action 

 Show terminated employees - include ex-employees in the report. 

Employee Benefits 

 Show only current benefits - display only those benefits that currently apply to employees. 
 Show only historical benefits - display only those benefits that no longer apply to 

employees. 

Employee Career Planning 

None. 
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Employee Details 

 Show terminated employees - include ex-employees in the report. 

Employee Details Summary 

 Show terminated employees - include ex-employees in the report. 

Employee Exit Interviews 

 Show terminated employees - include ex-employees in the report. 

Employee Induction 

 Show only completed induction points - display only those Induction Plan Points that have 
been marked as completed. 

 Show only completed induction points - display only those Induction Plan Points that have 
not yet been marked as completed. 

Employee Leave History 

 Show terminated employees - include ex-employees in the report. 

Employee Notes 

 Show terminated employees - include ex-employees in the report. 

Employee Performance Reviews 

None. 

Employee Quals. & Education 

None. 

Employee Renum. & Benefits 

None. 

Employee Remuneration 

 Show only salary remunerations - display only remuneration records that relate to salaries. 
 Show only wages remunerations - display only remuneration records that relate to wages. 

Employee Skills 

None. 

Employee Tasks/Duties 

None. 

Employee Training 

 Show incomplete training only - display only training that has not yet been marked as 
complete. 
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Employee Work History 

 Show terminated employees - include ex-employees in the report. 

User Defined1 

None. 

User Defined2 

None. 

Maintenance Reports 

Employee Groups 

None. 

Exit Interview Procedures 

None. 

Induction Plan 

None. 

Performance Reviews 

 Print signature line - select this option to include a line for the employee to sign on at the 
end of each plan. 

Positions 

None. 

Skills by Employee Group 

None. 

Skills by Position 

None. 

Skills by Skill 

None. 

Tasks/Duties by Employee Group 

None. 

Tasks/Duties by Position 

None. 

Tasks/Duties by Tasks/Duties 

None. 

User Security 

None. 
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Training Reports 

Training Courses 

 Show User Defined... - specify whether or not to include each of the various fields set up 
on the User Defined tab of the Training Courses window. 

Training Providers 

None. 

Report Runs 

A report run is a way of grouping reports together to process several at a time. This saves the 
repetitive task of having to navigate to, set up, preview, and print the same reports from the Select 
Report screen every time you need them. When a report is in a run, it can be customised 
permanently for that run. 

Report runs are set up and run from the Report Runs tab of the Select Report window (see page 
97). Selecting Report Runs from the Reports menu opens the Select Report window with the 
Report Runs tab automatically selected: 
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The following options are available on the Report Runs tab, which affect all reports generated 
from report runs: 

 View PDF files after creation - if this option is ticked, PDF reports will be opened in your 
default PDF viewer application when they are created. 

 Confirm before overwriting existing files - if this option is ticked, you will be asked for 
confirmation if any of the report files you are generating will overwrite an existing file. If it is 
not ticked, files will be overwritten automatically. This option is disabled if Append output 
file name with date and time stamp is ticked, as files will always be unique in this case. 

Adding Report Runs 

To add a Report Run: 

1. Click Add or press F4. The Edit Report Run screen appears: 

 
2. Enter a Name and Description for this report run. 

3. From the Select Report window on the left, select any report for inclusion into the report 
run. Double-click on a report, or select the report and click the > button to move the 
selected report to the Reports window. Reports in the Reports window can be re-ordered 
by dragging them up and down. 

4. Customise each report. You do not need to customise a report if the default settings suit 
you; however, it is a good idea to check how the current defaults. 

To customise a report, double-click on a report in the reports window, or select the report, 
then click Edit or press F5. The Print Report screen (see page 97) for that report appears. 

Enter values into the selection ranges to print for specific departments/cost centres as 
necessary. 
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Set the report destination for each report. 

TIP: This lets you send certain reports to go to certain printers. You can set all reports  
destinations to Screen  to preview each report before it goes to the printer. 

You can set any number of options to do with what to show or what to hide on the report, 
choose between summary and detail view, or choose the page orientation. 

5. Once you have finished customising the report, click Save or press F10 to permanently 
save your settings, then click on Exit or press ESC to return to the Edit Report Run screen. 
 
Click Save or press F10 to save the report run (and the reports in it) and return to the report 
run selection screen, from which you can proceed to print the run. 

Editing Report Runs 

You can select an existing report run on the Report Runs tab and click Edit or press F5 to add, 
remove or edit the reports in that report run. 

Clicking Delete or pressing F6 removes the currently selected run from the report run list. 

Printing Report Runs 

Click Print on the Select Report screen to print the currently selected report run. All of the reports 
in the run are printed in one sequence. 

ReportWriter 

MYOB ReportWriter is a query and report writing tool that enables you to extract information from 
your MYOB system and format it into a variety of outputs including reports, spreadsheets, graphs, 
labels, and others. You can access ReportWriter from within Exo Employee Information by 
selecting ReportWriter from the Reports menu. 

Help for the ReportWriter is available by pressing F1 while using it. 
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Security Groups 

Employees can be grouped into Security Groups, which are applied to individual users on the User 
Security window. This determines who is able to look at which employees  data, enabling security 
to be self-contained to one or many sets of employees per user. 

To set up Security Groups, select Security Groups from the Utilities menu  A list of the currently 
available groups appears. Click Add to create a new group, or highlight an existing group and click 
Select to edit it. Security Groups are added and edited on the following window: 

 
All available employees are listed on the left; all employees that the current user is allowed to 
access are listed on the right. You can click on items and drag them from one list to the other. 

>  Moves the selected employee to the list on the right. 

>>  Moves all employees to the list on the right. 

<  Moves the selected employee from the list on the right back to the main list on the left. 

<<  Moves all employees from the list on the right back to the main list on the left. 
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Event Log 

MYOB Exo Employee Information can be set up to keep a log of the following events: 

 When an employee record is added, edited or deleted. 
 When a Disciplinary Action is added, edited or deleted. 
 When a Performance Review is added, edited or deleted. 

Setting up Event Tracking 

To specify what events should be tracked in the Event Log, select Event Tracking from the Utilities 
menu. The Event Tracking window appears: 

 
This window display which events are being tracked for each type of item. To alter the events 

being tracked for an item, click the   button next to that item. This opens the Track Changes 
window: 

 
Events listed on the left are not tracked in the Event Log; events listed on the right are tracked. 
Select an event and click the > button to add it to the list of tracked events on the right. Select a 
tracked event and click the < button to remove it from the list of events being tracked. The >> and 
<< buttons move all events from one list to the other. Click Save when you are done. 
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Viewing the Event Log 

Once Event Tracking has been set up, records are automatically inserted into the Event Log. To 
view the Event Log, select Event Log from the Utilities menu. 

 
Select an item and click Edit to see a summary of the event. For Edit events, a comparison 
between the old value and the new value is available. 

Select an item and click Delete to remove it from the log. 

Upgrading 

You can upgrade your current version of MYOB software by selecting Upgrade Software from the 
Help menu. 

NOTE: If several users are operating MYOB software across a network, they all must exit 
their MYOB software before you start the upgrade process. 

Selecting this option opens the Upgrade Software window: 
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Either: 

 Use the combo box to select the disk drive holding your MYOB CD. 

 Click the   button to specify the location of the upgrade program (upgrades.exe), which 
can be stored on a file server, and run from that location on the server. 

Once you have selected the location of the upgrade, you will be exited from your MYOB software, 
for the upgrade process to begin. Follow all onscreen prompts to complete the upgrade of the 
Exo Employee Information software. A restart may be required. After the restart, open Exo 
Employee Information in the normal way. If a restart is not required, Exo Employee Information is 
started automatically following the upgrade. 

When you restart Exo Employee Information, the upgrade process for your company files will 
begin automatically. The Upgrade Software window appears, prompting you to specify which 
companies you want to back up during the upgrade process. 

 
Select which companies you want to back up and click the > button to move them to the list on 
the right. During the upgrade, a backup will be made for each company listed on the right of the 
screen. 

If you chose to back up your companies, the backup is performed before that company s data is 
upgraded. As each company is upgraded, the names of the files being upgraded are displayed in 
the top right corner of the screen. Do not interrupt this process. It may take several minutes. 

You may be prompted to Convert 3.0 resource file to 6.0 format . Click Yes. 

Once the upgrade process has finished, you will be returned to the company selection window. 
You can now continue using the software in the normal way. 
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Upgrading Software Online 

From within Exo Employee Information you can check if any updates are available online, and if 
so, download and install them immediately. Select Upgrade Software Online from the Help menu. 
The following window is displayed: 

 
Follow the onscreen instructions to update your software online. 

If you haven t updated your software for a while, a window will be displayed to remind you to 
check for updates when you exit out of the software: 
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